
  

  User Guide 

Scaffold Designer is a simple but powerful scaffold drawing tool that allows the design of scaffold structures of 
any complexity and generates a bill of materials automatically. This guide covers Scaffold Designer navigation, 
features, and use.  Please see the Scaffold Designer Installation Guide for installation instructions.  
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Warning: 
This Product (as defined below) is intended for use by qualified scaffolding designers and/or competent persons as defined by OSHA 
and other applicable regulatory bodies. Use by unqualified persons may result in DEATH, SERIOUS PERSONAL INJURY, OR 
PROPERTY DAMAGE. Loads are determined by this Product based on the load-carrying capacity of a single leg. The total loads on 
individual components (plank, side bracket, etc.) as well as the loading of the scaffolding assembly (dead load, live load, wind load, 
seismic load, etc.) must be considered by any user of this Product. The Product provides no engineering checks or regulatory 
validation routines. You are entirely responsible for ensuring that the outputs generated by the Product are sufficient for your purposes 
and that they comply with any applicable laws or regulations. 

Getting Started 
Every time you launch Scaffold Designer, the Backstage within the Start tab will appear.  While in a drawing, you 
navigate back to the Backstage by selecting Start. 

Backstage 
The Backstage is where new scaffold drawings begin, existing drawings are opened, and the Material Master is 
viewed as well as maintained.  For information about the default parts in the Material Master and customization, 
see the Material Master section.   
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New 
1A  Select this option to start a new drawing.  This is selected by default whenever the Backstage is open 

Custom Design Scaffold 
1C  The Custom Design Scaffold section allows Metric or US units to be used for the scaffold bays and parts for 

a new scaffold drawing.  By default US Units is selected, select Metric Units if this will be your standard of 
measurement for the new drawing. 

Select Scaffold Material 
1D  The Select Scaffold Material section of the Backstage allows 

different scaffold systems to be used in the new scaffold drawing. 
The scaffold material type chosen for the drawing will affect the 
material available to be used and viewed in the bill of materials.  As 
an example, choosing Cup Type scaffold material for the drawing will 
make Cup Type material available. 

Round Tank Wizard 
1E  The Round Tank Wizard is a plug in to assist with the creation of scaffold drawings for the inside and/or 

outside of circular objects such as tanks.  This plug in is disabled by default and requires separate installation to 
enable this feature. 
 
For more information about using the Round Tank Wizard, please contact Avontus Software. 

Open 
1A  Select Open to browse, select, and open an existing drawing.  Scaffold Designer allows you have multiple 

drawings open at the same time.  Drawings must have a file extension of .vsdx.  If the drawing has been modified 
in another program, some features or functions may be disabled when editing in Scaffold Designer 

Close All 
1A  Select Close All to close all of the currently open drawings.  To close drawings individually, click X Close on 

the drawing’s tab. 

Recent 
1A  Selecting Recent will display a list of the most recently created or edited drawing.  By default, this list will 

display 10 results. 

Help 
1F  From Help you can access the following tools: 

 Activation Manager – For more information about Activation, please refer to the Scaffold Designer 
Installation Guide. 

 Automatic Updates – Select this option to check for updates to Scaffold Designer.  

 Contact Us  

  

NOTE: While all three material types are 

available in the Material Master, choosing 

the material type for the drawing will 

dictate the material available for use in 

that drawing. 



 
 

©2013 Avontus Software Corporation User Guide v3.0 | 4 
 

Scaffold Designer User Guide   

Material Master 
1B  The Material Master is the core parts list used for drawings, the Bill of Materials, and scaffold calculations in 

Scaffold Designer.  With a new installation of Scaffold Designer, this list will default with some materials already 
available for use.  The Material Master is completely customizable so you can create a list that matches the 
materials available from your supplier(s) or within your own inventory.  If you will be integrating with Quantify, this 
list should be updated to match your Quantify Product Catalog.  For more information about integration, see 
Integrating with Quantify/ Quantify Web section. 

 
The measurements, weights, and other information entered here will be 
used when generating a Bill of Materials for a scaffold.  Also, these 
measurements are used for calculations such as scaffold dimensions.  It is 
important that these match your supplier’s listed specifications to ensure 
drawing accuracy. 
 

Editing Material 
To edit the Material Master, select Material Master from the Backstage.  This will launch the ‘Material Master’ 
dialog. 
 

 
 
To edit an existing part, select the Part in the grid.  Click in the desired field 
and edit the information.  Continue to edit parts as desired.  Click Save when 
ready.   
 
You may also add or remove parts from the Material Master list by using Add 
Material or Remove Material in the Edit group. 

  

NOTE: The Material Master can be 

viewed at any time, but to make 

changes, all drawings must first be 

closed before opening. 

WARNING: Clicking Undo 

Changes will undo all changes 

made since the last Save. 
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Inside Scaffold Designer 
When working on a new drawing or editing an existing drawing, the following sections can be displayed or 
removed from the display.  To add a section back onto the display, select the section from the View tab. 
  

 
 

Scaffold Designer Ribbons 
The ribbon contains the Start, Home, Scaffold, Drawing, and View tabs with multiple groups in each tab.  Scaffold 
Designer controls are categorized in Ribbons, by tab and then by group.  Similar type controls are combined 
within tabs and groups to make them logically easy to find and use.   
 
3A  Selecting the Scaffold tab will display the Scaffold Ribbon which contains many of the controls needed for 

creating a scaffold drawing. See the Scaffold Ribbon – Controls by Group section for details on each of the 
controls in the Scaffold Ribbon. 

Drawing Stencil 
3B  The Drawing Stencil provides various smartshapes that can be used in Scaffold Designer drawings.  These 

shapes can be added to the drawing by dragging and dropping the shape into the Drawing Page.  Once a 
smartshape is added to the page, it can be sized as needed. 



 
 

©2013 Avontus Software Corporation User Guide v3.0 | 6 
 

Scaffold Designer User Guide   

Drawing Page 
3C  The Drawing Page is where scaffold drawings are created.  The page is blank when a new drawing is started.  

Additional pages can be added to a drawing as well as a Bill of Materials, 3D Model, and more. 

3D View 
3D  The 3D View displays a 3D rendering of the drawing.  Use the Wireframe or Model tabs to toggle between the 

available views.  Use the controls within each tab to adjust the image:  
 

  Zoom Window – Zoom to fit a drawn window area. 

  Zoom – Increase or decrease the zoom manually. 

  Pan – Move the image location in the window. 

  Rotate – Rotate the image on an axis.  The axis is determined by the location where the image is 

clicked. 

  Zoom Fit – Changes the image size to fit the complete image or grid in the window. 

  Toggle Perspective/Parallel View – Changes the perspective to be parallel with the image.  Click again 

to change back to the previous perspective. 

  Copy to Clipboard – Copies the image to the clipboard.  Some adjustments may occur during this 

process. 

 

4A  The View Cube is a useful tool that allows you to adjust the image’s pan and rotation at the same time.  You 

can also use the View Cube to toggle the perspective to a specific location.  Click the desired location on the cube 

and drag to change the image’s orientation.  To view the image parallel to a specific side, edge, or corner, click 

that location on the cube and release.  The image will automatically adjust using the selected location as a center 

point.  Use the compass below the cube to reference the image’s orientation to the drawing as designed in the 

Drawing Page. 

 
Below are the Wireframe and Model views as shown in the 3D View section for the same scaffold drawing. 
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Bay Level Editor 
3E  The Bay Level Editor contains the controls for individual Bays.  The details and controls for a specific Bay will 

appear when that Bay is selected in the Drawing Page.  Controls in the Bay Level Editor include: 
 

  Plank All – Planks every level of a Bay 

  Plank Every Other – Planks every other level of a Bay.  

Defaults to plank odd numbered levels. 

  Invert Planked – Planks the currently non-planked levels and 

removes the planks from the currently planked levels. 

  Reset Overrides – Removes customizations made to the Bay. 

 Side Brackets – Add or remove side brackets from any side of the 

Bay. 

 More – Additional controls such as Guardrail Type, Toeboard Type, and Diagonal Brace Direction. 

 

   

TIP: If you will have many Bays with 

similar or the same details, add the first 

Bay to the drawing.  Edit the Bay Levels 

to include the attributes needed.  Then, 

use the Add Bay to Side or Copy and 

Paste features to add another Bay with 

the same attributes. 
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Create a Scaffold Designer Drawing 
This section will outline how to create this example L-shaped scaffold drawing using some of the key controls and 
features of Scaffold Designer.  This example uses default Material Master parts. 
 

 
 

Start a Drawing 
7A  To start a new drawing, open Scaffold Designer.  The Backstage will launch with the New option already 

selected. 
 
7B  First, the unit of measure must be selected.  This drawing will use the default selection US Units.  

 
7C  Next, select the Scaffold Material.  This drawing uses Cup Type Scaffold.  After selecting the Scaffold 

Material, a new Drawing Page will launch. 
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Add a Bay 
8A  The Scaffold tab will be active by default.  From this tab, click and drag the New Bay shape to the middle of 

the Drawing Page. A new default Bay is added. 
 
8B  The 3D view will update to reflect the newly added bay on the drawing page. 

 
8C  The Bay Level Editor will display details for this Bay. 

 

 
 

Edit Bay Levels 
9A  Within the Bay Level Editor, click Add Level to add a planked level to the selected Bay. Repeat to create a 

Bay with 3 levels. 
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Add Additional Bays 
10A  The selected Bay will be used as a template for Bays added to any of its sides.  With this Bay still selected in 

the Drawing Page, locate the Add Bay to Side control in the Scaffold tab.  Click the Left direction to add a Bay to 
the left side of the selected Bay.  Repeat to create a total of 4 Bays.  The added Bays will have the same 
dimensions and properties as the copied Bays.   
 

 
 
The most recently added Bay will be selected in the Drawing Page by default.  Click the Top direction in the Add 
Bay to Side control to add a Bay to the Top of Bay 4. 
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Change Bay Dimensions 
12A  Bay 5 will have different dimensions from the rest of the Bays.  The most recently added Bay will be selected 

in the Drawing Page by default.  With Bay 5 selected, locate the Bay Size/Elevation control in the Scaffold tab.   
 
13A  Edit the LR dimension to 8ft.  Once this option is selected, the drawing and 3D View will update. 

 

     
 

Save 
To save a drawing at any time, select the Home tab.  Click Save > Save As to choose a save location and 
filename for the active drawing.  The L-shaped example drawing is complete! 

Finishing a Drawing 

Title Block 
14A  A Title Block is placed on each drawing so that the various project properties can be printed with the drawing.  

Each page of a drawing will contain a unique Title Block in the lower right hand corner. 
 
To edit the information within the Title Block including the Description, Job, 
Customer, and Date, select Title Block from the Home tab.  This will launch 
the ‘Title Block’ dialog for the active Drawing Page.  Make any of the desired 
changes.  To apply these changes to all pages of a drawing, select the option 
Apply Job, Customer, and Date to All Pages.  Click OK when ready. 
 

 
 

NOTE: The Scale and Sheet 

sections of a Title Block are 

automatically updated with the 

properties of a drawing. 
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Bill of Materials 
15A  Scaffold Designer can create a Bill of Materials for a scaffold drawing.  The Bill of Materials calculates and 

displays a list of materials required to build a scaffold as drawn.  This will include the Quantity of Parts, total 
Weight/Volume, and Netting Area which will appear in the drawing’s selected Unit of Measure.  To create a Bill of 
Materials, click Bill of Materials from the Scaffold tab.  The ‘Bill of Materials’ dialog will launch. 
 

 
 
The Bill of Materials for a drawing can be edited to Add Parts, Modify 
quantities, change the Description of a Part, and more.  Once complete, 
the Bill of Materials can be Printed, Copied, or exported to Quantify to 
create an estimate.  See Integrating with Quantify/ Quantify Web section 
for more information about exporting the Bill of Materials.  
 

Copying the Bill of Materials to a Drawing 
A copy of the Bill of Materials can be added to any page of a 
drawing.  To add the Bill of Materials, select Bill of Materials 
from the Scaffold tab.  Make any desired changes such as 
adjusting the Weight of materials.  Once changes are complete, 
click Copy to Clipboard.  Click Close BOM to return to the 
Drawing Page. 
 

  

NOTE: Changes made to the Bill 

of Materials, such as modifying 

quantities, will not change the parts 

used in the associated drawing. 

WARNING: Changes made to the drawing 

after adding the Bill of Materials will not be 

included in the drawing image.  To include 

these changes, delete the Bill of Materials 

image and copy the updated Bill of Materials 

to the drawing. 
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You can paste the Bill of Materials to any page of the drawing using standard Windows commands.  Right-click 
the Drawing Page and select Paste to paste an image of the Bill of Materials.  This image can be sized and 
moved to the desired location on the page.  
 

 

Leg Loads 
Scaffold Designer can calculate the Leg Loads for a scaffold.  The Leg Loads Table calculates the Dead Load, 
Live Load, and Total Load for each leg in a scaffold drawing based upon the size, height, location, materials, 
braces, and other variable factors. 
 
To calculate Leg Loads for a drawing, click Leg Loads from the Scaffold tab.  The ‘Leg Loads Table’ dialog will 
launch.  Enter the Unit Live Load amount and the Number of Usable Deck Levels.  Both of these values will be 

used to calculate the Live Load and Total Load.  Click Calculate when ready. 
 
17A  The table will display all legs based upon the drawing’s specifications.  If 

Legs are shared, they will only be displayed once in the table.  The Leg with the 
most load will be highlighted in red and the load details for this leg will also be 
displayed in the Critical Leg Load status line. 

 
 

TIP: Use the directional 

graphic to quickly identify 

Leg numbers for a Bay. 17B  
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Copying Leg Loads to a Drawing 
A copy of the Leg Loads Table can be added to any page of a drawing.  To add the Leg Loads Table, select Leg 
Loads from the Scaffold tab.  Add the required values and Calculate.  Click Copy to Clipboard.  Click Close to 
return to the Drawing Page. 
 
You can paste the Leg Loads Table to any page of the drawing using standard Windows commands.  Right-click 
the Drawing Page and select Paste to paste an image of the Leg Loads Table.  This image can be sized and 
moved to the desired location on the page.  

Adding a 3D View to a Drawing 
The Wireframe and Model views of a scaffold can be copied to the clipboard as an image file.  These images can 
then be added to a Scaffold Designer drawing or used in other programs.  To make this image visible in Quantify 
Web, see Integrating with Quantify/ Quantify Web section. 
 
To add a 3D View to a drawing, select the Wireframe or Model tab 
within the 3D View section.  Make any desired changes such as 

adjusting the Angle.  Click  Copy to Clipboard when ready.  You 
can paste the 3D View to any page of the drawing using standard 
Windows commands.  Right-click the Drawing Page and select Paste 
to paste an image of the 3D View.  This image can be sized and 
moved to the desired location on the page.  You may repeat these 
steps to add multiple 3D Views, such as different Perspectives, to the 
same drawing.   
 

 
 
      
  

WARNING: Changes made to the 

drawing after adding the 3D View will not 

be included in the drawing image.  To 

include these changes, delete the 3D 

View image and copy the updated 3D 

View to the drawing. 
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Integrating with Quantify/ Quantify Web 

Quantify 
Scaffold Designer integrates with Quantify to turn your drawing into an estimate, eliminating the need to duplicate 
effort entering materials needed for a job.  For successful integration, some setup is required. 

Material Master and Product Catalog Matching 
Quantify uses the Bill of Materials calculated for a drawing to automatically populate the Products on a new 
Estimate.  To ensure all Products are added properly, Scaffold Designer’s Material Mater should contain the same 
parts, part numbers, and information as Quantify’s Products Catalog.  The Part Number detailed in Scaffold 
Designer’s Material Master will be used during integration to identify matching materials with the same Part 
Number in Quantify’s Product Catalog. Details such as part descriptions, weight, etc are not required to match, 
however it is recommended that these fields match as well to prevent incorrect entries. 
 
If a conflict exists, such as a Part Number that is not in Quantify’s Product Catalog, the material will not be added 
to the Estimate.  A list of excluded materials will display in Quantify after the integration is complete. 

Create an Estimate from a Drawing 
Once a drawing is complete, click Bill of Materials from the Scaffold tab.  This will launch the ‘Bill of Materials’ 
dialog.  Make any desired changes to the list of materials.  Click Quantify when ready.  If Quantify is installed on 
the same computer, choose Open in Quantify.  If Quantify is not currently open, you will be prompted to login 
during the integration.  If Quantify is not installed on the same computer as Scaffold Designer, or if you want to 
integrate with another user’s Quantify, choose Save as Quantify File...  Then, in Quantify, the user will need to 
select Import File from Scaffold Designer in the Estimates tab to complete the integration. 
 
In Quantify, the ‘Estimate’ dialog will launch.  In the Products tab, the matched materials from the Scaffold 
Designer Bill of Materials will already have the appropriate Quantities entered.  In the Summary tab, the Scaffold 
Designer drawing and Scaffold Designer web drawing are added as attachments to the Estimate.  Complete the 
Estimate by adding any additional information as desired.  Click OK when ready. 

Quantify Web 
Quantify Web is specially designed to display Scaffold Designer drawings that have been attached to Scaffold 
Tag jobs.  To make a drawing visible on Quantify Web, first create an Estimate.  See Create an Estimate from a 
Drawing for more information. 

Attach the Drawing to a Scaffold Tag Job 
After saving the Estimate in Quantify, it can be used to create a 
Shipment to a Scaffold Tag job.  Select the Estimate in the Estimates 
tab in Quantify and select Copy To > Shipment to Scaffold Tag.  
Enter the required information and confirm the option Copy 
Attachments from Estimate… is selected.  Click OK when ready.  
The ‘New Direct Ship’ dialog will launch.  Enter additional information 
as desired and click OK when ready. 

Viewing a Drawing in Quantify Web 
To view a drawing in Quantify Web, Login to the customer site.  Select the 
Scaffold Tag Job from the Organization Tree.  Select the Drawings tab.  Click to 
open the desired drawing.  The drawing will launch in a new tab or window of your 
browser. 
 
 

  

TIP: Use Internet Explorer 

to gain access to drawing 
controls such as zoom and 
bay details. 

NOTE: Drawings in Quantify Web are 

view only.  To make changes to a 

drawing, use Scaffold Designer.  After 

saving the changes, the new drawing will 

need to be attached to the Scaffold Tag 

Job manually. 
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Export to AutoCAD 
You can export your Scaffold Designer drawing into AutoCAD using either the 2D or 3D option. Exporting to 2D 
will preserve the drawing block and all text, while opening in 3D provides objects that are ready for rendering in 
3D.  

 

19A  To export your drawing to AutoCAD, you must have AutoCAD installed or 

accessible on the same computer as Scaffold Designer.  When ready, select the 
Home tab.  Click Open in AutoCAD, then select the desired format, 2D (Active 
Page) or 3D (Scaffold Model).   
 

  
 

21A  The drawing will open in AutoCAD.  You may be presented with a dialog box informing you that the drawing 

did not originate in an Autodesk product. Select Continue Opening the DWG File to open the drawing. 

  

TIP: Use the AutoCAD 

zoom extents command 
to view the drawing after 
opening in AutoCAD.  
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Scaffold Ribbon – Controls by Group 
Below is a detailed list of the Controls located in the Scaffold tab of Scaffold Designer.  For information about the 
controls located elsewhere in Scaffold Designer, please refer to the Help resources for Microsoft Visio® 2013. 
 

New 

 

New Bay 
Adds a new default Bay to the drawing.  To add a Bay, drag Bay shape to 
the Drawing Page and place where desired.  This Bay can now be edited 
using the Bay Level Editor and other controls. 

 

Connector Bay 
Adds a new default Connector Bay to the drawing.  To add a Connector 
Bay, drag Connector Bay shape to the Drawing Page.  Drag the corners to 
the desired connection points on the adjoining Bays.  For triangular Bays, 
drag both corners to the same connection point on the adjoining Bay. 

 

Convert Selected 
A sub-control of Connector Bay.  Converts the selected Bay to a Connector 
Bay.  See Connector Bay control for details. 

Add Bay to Side 

 

Adds a new Bay to the selected Bay.  The new Bay will have the same 
attributes as the selected Bay.  To add a Bay to a side, select an existing 
Bay in the drawing, then click a side or corner location.  To add Bays to all 

sides, click  All. 

Modify 

 

Re-Join Bays 
Updates and recalculates selected Bay.  This can be used to ensure added 
bays share legs with existing Bays, Guardrails do not block the deck path, 
and other necessary adjustments.  To Re-Join Bays, you can use standard 
Windows commands to select multiple Bays.  Click an area of the Drawing 
Page and drag to highlight an area, all Bays within that area will be 
selected.  Click Re-Join Bays when ready 

 

Delete Bays 
Deletes the selected Bay(s).  To delete 
Bays, you can use standard Windows 
commands to select multiple Bays.  Click 
an area of the Drawing Page and drag to 
highlight an area, all Bays within that area 
will be selected.  Click Delete Bays when 
ready.  

Model/Materials 

 

Bill of Materials 
Creates a Bill of Materials for the active drawing.  See Bill of Materials 
section for more information. 

NOTE: Only adjoining Bays 

can be deleted at once.  To 

delete separated Bays, 

delete each individually. 
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Update Model 
Updates the 3D Model View of the drawing.  Some changes to a drawing 
such as adding smartshapes require an update to include these changes in 
the Model View.  To update the 3D Model View, make any desired 
changes to the drawing then click Update Model when ready.   

 

Leg Loads 
Calculates the Leg Loads for a scaffold.  See Leg Loads section for more 
information. 

Bay Size/Elevation 

 

TB 
Sets the selected Bay(s) width.  The width is the distance between the Top 
and Bottom Ledgers of a Bay.  To set the width of Bays, you can use 
standard Windows commands to select 
multiple Bays.  Click an area of the 
Drawing Page and drag to highlight an 
area, all Bays within that area will be 
selected.  Choose the desired width 
and materials for the Bays when ready.  

LR 
Sets the selected Bay(s) height.  The 
height is the distance between the Left 
and Right Ledgers of a Bay.  To set the height of Bays, you can use 
standard Windows commands to select multiple Bays.  Click an area of the 
Drawing Page and drag to highlight an area, all Bays within that area will 
be selected.  Choose the desired height and materials for the Bays when 
ready. 

Start Node 
Changes the starting elevation of the Bay(s).  Each increment increases or 
decreases the elevation by 0.5 meters (1.64 feet).  To change the elevation 
of Bays, you can use standard Windows commands to select multiple 
Bays.  Click an area of the Drawing Page and drag to highlight an area, all 
Bays within that area will be selected.  Choose the desired Start Node for 

the Bays and click  Apply when ready. 

Bay Properties 

 

Side Settings 
Modifies side attributes of a selected Bay.  To update Side Settings, select 
an existing Bay and click Side Settings to access the following controls: 

 

Guardrails 
A sub-control of Side Settings.  Click the desired side to add a Guardrail.  

Click the corner location to add Guardrails to the adjacent sides.  Click  
All to add Guardrails to all sides of the selected Bay.  By default, the 
Guardrails will be added to all planked levels within the Bay.  To further 
edit Guardrail locations, adjustments can be made in the Bay Level Editor.  
For information about editing the Guardrail Type, see Bay Details control.    

NOTE: The size and material 

options provided in these lists 

are based upon the parts in the 

Material Master.  The lists are 

filtered to display only those 

parts for the selected Scaffold 

Material for the drawing. 
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Vertical Braces 
A sub-control of Side Settings.  Click the 
desired side to add Vertical Braces.  Click the 
corner location to add Vertical Braces to the 

adjacent sides.  Click  All to add Vertical 
Braces to all sides of the selected Bay.  By 
default, Vertical Braces will be added to all levels of a Bay with a Forward 
direction.  To further edit Vertical Brace locations, adjustments can be 
made in the Bay Level Editor.  For information about editing the Diagonal 
Brace Direction, see Bay Details control.  

 

Netting 
A sub-control of Side Settings.  Click the desired side to add Netting.  Click 

the corner location to add Netting to the adjacent sides.  Click  All to add 
Netting to all sides of the selected Bay.  By default, Netting will be added to 
all levels of a Bay.  To further edit Netting locations, adjustments can be 
made in the Bay Level Editor using the More control. 

 

Bay Details 
Changes the details of the selected Bay.  By default, the changes made 
will apply to all sides of the Bay, where applicable.  To make changes to a 
specific side, select the side location at the top, then make the desired 
changes.  Click OK when ready.  These changes will apply to all levels that 
contain this type of item.  To make similar changes to specific levels of a 
Bay, use the Bay Level Editor. 

 

 

Plank Direction 

Changes the direction of the Planks for selected Bay(s).  Planks can be  

Parallel or  Perpendicular in direction.  To change the direction of Planks 
within Bays, you can use standard Windows commands to select multiple 
Bays.  Click an area of the Drawing Page and drag to highlight an area, all 
Bays within that area will be selected.  Click Plank Direction to change all 
planks to match direction or choose the desired Plank Direction from the 
drop-down options.  

  

NOTE: The number 

and locations of Vertical 

Braces will effect Leg 

Load calculations. 
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Ladders 
Adds Ladders to the selected Bay.  To add Ladders, select a Bay within the 
drawing and click Ladders.  This will launch the ‘Bay Ladders’ dialog. 

 
 
Select the desired settings for the Ladder and click Add Ladders when 
ready.  To edit an existing Ladder, select the Bay containing the Ladder 
and click Ladders.  Make the desired changes and click Recalculate 
Ladders when ready. 

 
Ties 
Adds Ties to the selected Bay.  To add Ties, select a Bay within the 
drawing and click Ties.  Select the desired Tie Options and click OK when 
ready. 
 

 

 
Stair Tower 
Adds a new default Stair Tower to the drawing.  To add a Stair Tower, drag 
Stair Tower shape to the Drawing Page and place where desired.  This 
Stair Tower can now be edited using the Bay Level Editor and other 
controls. 

 
 


